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1 

Introduction 

Oracle Governance, Risk and Compliance Controls (GRCC) regulates activity in 

Oracle E-Business Suite and PeopleSoft Enterprise, and may be configured to reg-

ulate activity in other business-management applications as well. GRCC consists of 

two components, each of which enables users to create ―models‖ and ―controls‖ that 

define risks a company may face: 

• Oracle Enterprise Transaction Controls Governor (ETCG) implements models 

and controls that specify circumstances under which individual transactions dis-

play evidence of error, fraud, or other risk. 

• Oracle Application Access Controls Governor (AACG) executes models and 

controls that define conflicts among duties that can be assigned in a company’s 

applications, and identify users who have conflicting access to those duties. 

In Oracle E-Business Suite or PeopleSoft Enterprise, AACG can also implement 

―preventive analysis‖ — it can evaluate controls as roles or responsibilities are 

assigned to users, preventing them from gaining risky access.  

You can install version 8.6.0 of Governance, Risk and Compliance Controls, or you 

can upgrade to it from version 8.5.1. (To upgrade an earlier version, you must first 

upgrade from that version to 8.5.1.) To install version 8.6.0 or upgrade to it from 

8.5.1, complete the following steps: 

1. To implement preventive analysis in Oracle EBS instances, ensure that version 

7.3.2 of Preventive Controls Governor (PCG) is installed in each Oracle EBS 

instance that is subject to AACG analysis. (Earlier versions of AACG permitted 

the use of earlier PCG versions, but AACG 8.6.0 requires version 7.3.2 of PCG.) 

PCG is a set of applications that primarily apply controls within Oracle EBS, 

but that also support AACG preventive analysis. For installation instructions, see 

the Preventive Controls Governor Installation Guide for version 7.3.2. 

There is no similar prerequisite for implementing preventive analysis in a 

PeopleSoft instance. 

2. Install version 8.6.0 of GRCC, or upgrade to it from version 8.5.1: 

• For a new installation, install an Oracle database and other prerequisite soft-

ware, and create a GRCC schema in the database. For an upgrade, you can 

reuse the database and GRCC schema created for version 8.5.1, but will need 

to upgrade your web application server (see ―Prerequisites,‖ page 1-3). 
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• Download GRCC installation files and perform the GRCC installation. 

• Optionally, configure the information AACG uses to create ―global users.‖ 

Each person who uses business-management applications has user-account 

information that may vary from one application to the next. For each such 

person, AACG creates a ―global user‖ and maps that person’s business-

management application IDs to it. 

• Configure connections to business-management applications in which 

AACG and ETCG models and controls are to be run.  

To complete these procedures, see Chapter 2 of this manual. 

3. Perform an additional Preventive Enforcement Agent (PEA) installation in each 

instance of Oracle EBS or PeopleSoft that is to be subject to preventive analysis. 

For Oracle PEA installation, see Chapter 3 of this manual; for PeopleSoft PEA 

installation, see Chapter 4.  

Upgrading 

As noted earlier, you can upgrade to GRCC version 8.6.0 only from version 8.5.1. If 

you wish to upgrade from an earlier version (8.5.0 of GRCC or 8.0–8.2.1 of AACG), 

follow one of these upgrade paths: 

Latest 8.2.1 patch > 8.5.0.2 > 8.5.0.4 > 8.5.0.6 > 8.5.1.183 > 

Latest 8.5.1 patches > 8.6.0 

Latest 8.2.1 patch > 8.5.0.2 (GA) > 8.5.1.183 (GA) > 8.6.0 (GA) 

As you upgrade from version 8.5.1 to 8.6.0, you must do the following: 

• Remove the contents of a directory that stores ETL data generated by Transac-

tion Controls Governor. (You will be directed to do this in step 3 on page 2-3.) 

• After upgrading to version 8.6.0 and connecting it to datasources, synchronize 

access data for each datasource. (You will be directed to do this on page 2-11.) 

• In version 8.6.0, evaluate all transaction models inherited from version 8.5.1. 

(See the Enterprise Transaction Controls Governor User Guide for information 

on running transaction models.) 

You can export content from one instance of GRCC and import it to another. 

(―Content‖ includes not only models and controls, but also templates from which 

models may be created, and ―global conditions‖ that set limits on the conflicts 

identified by access models or controls.) However, these operations are version-

specific; you cannot export content from a version-8.5.1 instance of GRCC and 

import it to a version 8.6.0 instance. So if you create a version-8.6.0 instance (either 

by installing it or by upgrading to it from a version-8.5.1 instance), and you want to 

transfer content to it from another, version-8.5.1 instance, you must upgrade that 

instance to 8.6.0 first. Doing so modifies its content for use in version 8.6.0. 

Supported Operating Systems 

GRCC runs on a server with, by preference, a Linux operating system. Windows 

Server is also supported. For details about supported operating systems, see the 

Oracle Governance, Risk and Compliance Controls Compatibility Matrix. 
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Prerequisites 

Before installing Governance, Risk and Compliance Controls, ensure that the follow-

ing are installed on the server: 

• Oracle 10g or 11g database. The certified version is 11gR1-64 bit.  

• Tomcat Application Server version 6.0.24. 

• Java: If you are installing on Linux, Sun Java Development Kit 1.6 or higher. If 

you are installing on Windows, Sun JDK or JRockit R27.5.0 for Java SE 6; the 

latter is recommended.  

In any case, GRCC must have its own dedicated Java container. It was not 

designed to coexist in a container with other web applications. 

Note: These component specifications, although accurate when the Installation 

Guide was written, are subject to change. Consult the most recent edition of the 

Oracle Governance, Risk and Compliance Controls Compatibility Matrix for 

confirmation. 

If you are installing on Linux, add the following to the /etc/security/limits.conf file: 

*    soft    nproc     8192 

*    hard    nproc     32768 

*    soft    nofile    65536 

*    hard    nofile    131072 

If you are installing on Solaris, set the following configuration parameter in 

/etc/system to protect against exploitation of buffer overflow attacks. (There is no 

need to do this for OEL or other Linux variations.) 

noexec_user_stack = 1 

On the server or a client system, either of the following web browsers can display 

the GRCC interface: 

• FireFox 3.5.x 

• Microsoft Internet Explorer 8, with the Adobe SVG plugin available from 

http://www.adobe.com/svg/viewer/install/mainframed.html. 

Restricted Use Licenses 

Restricted-use: WebLogic Suite, Oracle Data Integrator; each of which may only be 

used with the Application Access Controls Governor or Enterprise Transaction Con-

trols Governor product. 

Additional details on restricted-use rights: 

WebLogic Suite restricted to the following components: WebLogic Server and 

Diagnostics Pack for Oracle Middleware. The GRC application can only be deployed 

within a single GRC based WLS domain. 

Restricted use Oracle Data Integrator – Target Database (restricted to use with 

Application Access Controls Governor or Enterprise Transaction Controls Governor 

as the only target). 
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2 

Installing or Upgrading GRCC 

In broad terms, complete these steps to install version 8.6.0 of Governance, Risk 

and Compliance Controls, or to upgrade from version 8.5.1: 

1. For a new installation, create a GRCC schema in the Oracle database. For an 

upgrade, reuse the schema created for the earlier version; upgrade database and 

software components as needed (see ―Prerequisites,‖ page 1-3). 

2. For a new installation or an upgrade, download files to the GRCC server and 

prepare them for use. 

3. For a new installation or an upgrade, install and configure the software. 

Noting Your Current Settings 

During installation, you will need to enter settings that establish connectivity between 

GRCC and its database. If you are upgrading from version 8.5.1, take note of those 

settings now, so that you will have them at hand when you need to re-enter them. 

(Otherwise, skip ahead to the next section, ―Creating or Backing Up a GRCC 

Schema.‖) 

1. Start your existing instance of GRCC: Open a web browser and enter the 

following in the address field: 

http://host:tomcat_port/grcc 

Replace host with the fully qualified domain name (FQDN) of your GRCC 

server, and replace tomcat_port with 8080 (if you accepted the default value 

when you installed Tomcat) or your configured value (if you changed the 

default during Tomcat installation). 

2. Log on: Supply your user name and password, and click on Login. 

3. In the Navigation panel (to the left on the GRCC interface), expand the Administra-

tion entry (click on its plus sign), and then click on Application Configuration. 

4. An Application Configuration panel displays the settings you’ve established for 

most database-connectivity parameters. (For security purposes, it does not display 

the database password.) Copy the settings. (For example, highlight the fields 

displaying your settings by dragging your mouse across them, click on Ctrl+C 

to copy the settings, open a word processor or spreadsheet, and press Ctrl+V to 

paste in the copied settings.) 
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Creating or Backing Up a GRCC Schema 
If you are performing a new installation of Governance, Risk and Compliance Con-

trols, create a schema for it in the Oracle database. The following is a sample schema-

creation script in which it is assumed that you have created a tablespace for use by 

GRCC (called grcc_tablespace), and that the schema (user) name and password are 

grcc_user and grcc_password.  

create user grcc_user identified by grcc_password default 

tablespace grcc_tablespace quota unlimited on grcc_tablespace 

quota 0k on system; 

grant connect, resource to grcc_user; 

grant create any view to grcc_user; 

grant create any table to grcc_user; 

grant drop any table to grcc_user; 

If you choose to use the system tablespace, rather than create one specifically for 

GRCC, delete the phrase ―default tablespace grcc_tablespace quota unlimited on 

grcc_tablespace quota 0k on system‖ from the script. 

If you use an Oracle 10g or 11g database, run the following commands as the 

system user: 

ALTER SYSTEM SET open_cursors=1000; 

ALTER SYSTEM SET processes=400 scope=spfile; 

ALTER SYSTEM SET sessions=600 scope=spfile; 

If you use an 11gR2 or later database, also run the following command as the sys-

tem user:  

ALTER SYSTEM SET deferred_segment_creation=FALSE; 

After running these commands, bounce the database.  

If you are upgrading from version 8.5.1, you can use the schema created for version 

8.5.1. Before upgrading to GRCC 8.6.0, take a backup of your GRCC schema. 

GRCC may display information in any of twelve languages. If you wish to use the 

multilingual capabilities of GRCC, be sure the database that hosts the GRCC 

schema is set up for UTF-8 encoding. Specifically, the character set should be set to 

AL32UTF8. Refer to your Oracle Admin guide for information on verifying or 

configuring your database with the recommended character set.  

Downloading Files 
Before downloading files, create a staging directory on the GRCC server. When this 

directory is created, complete the following steps: 

1. Locate the Governance, Risk, and Compliance Controls Disk in your Oracle 

media pack. In its dist directory, locate the file grcc_86.zip. Copy the file to your 

staging directory, and extract its contents there.  

2. One of the files you’ve extracted is called grcc.war. Execute the following com-

mand to validate it.  

md5sum grcc.war 

In response to this command, a checksum value is returned. Ensure that it matches 

the following value: 

be43ee3c1b111909dcd55c5043cc7a05 
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Performing the Installation 

When the necessary files are downloaded, complete these steps: 

1. Shut down the Tomcat application server (or, if you are installing on a Windows 

server and run Tomcat as a Windows service, stop the service). 

2. If you are performing a new installation, create a directory for a Report Reposi-

tory, which stores GRCC report history — copies of reports that GRCC users 

schedule to be run. 

If you are upgrading, archive the reports generated through the use of version 

8.5.1, and then reuse the Repository for version 8.6.0. 

Note the path to the Report Repository, as you will need to supply it later as a 

configuration value. The Repository can reside on an NFS mount or any valid 

directory to which the user running Tomcat has full permissions. (If the Report 

Repository is deleted, then report history is lost.)  

3. Create a directory for the storage of ETL data used by Enterprise Transaction 

Controls Governor. For an upgrade, you may reuse the directory created for ver-

sion 8.5.1, but must remove all content from it. Again, note the path to this direc-

tory, as you will need to supply it later as a configuration value. 

4. If you are upgrading from version 8.5.1, remove the directory TomcatHome/ 

webapps/grcc, and all its contents. If you are performing a new installation, this 

subdirectory does not exist; skip this step. 

Note: Throughout this document, replace the value TomcatHome with the full 

path to the highest-level directory in which Tomcat components are installed. 

If you are upgrading, you should also remove the grcc directory from the Tom-

cat work area (TomcatHome/work/Catalina/localhost/grcc), and you may want to 

save Tomcat logs (located at TomcatHome/logs) to another location, then delete 

them.  

5. If you are upgrading from version 8.5.1, navigate to TomcatHome/webapps and, 

from it, delete the file grcc.war. If you are performing a new installation of GRCC 

8.6.0, ignore this step.  

6. If you are installing on a Windows server, open the file TomcatHome\conf\ 

server.xml. Locate the entry for the <Connector> port setting, and ensure that it 

contains the following value: 

URIEncoding="UTF-8" 

If you are installing on a Linux server, omit this step. 

7. Modify Tomcat settings: 

• If you are installing on a Linux server, locate the startup.sh file in the bin sub-

directory of the Tomcat home directory. Add these lines at the top of the file. 

CATALINA_OPTS="-Djava.security.auth.login.config= 

TomcatHome/webapps/grcc/WEB-INF/jaas.config 

-Doracle.security.jps.config=TomcatHome/bin/config/jps-

config.xml -Xss512k -Xms256M -Xmx4096M 

-XX:MaxPermSize=256m -XX:+UseParallelGC 

-Djava.awt.headless=true" -XX:-UseGCOverheadLimit 

export CATALINA_OPTS 



 

2-4 Oracle Governance, Risk and Compliance Controls Installation and Upgrade Guide 

• If you are installing on a Windows server, use batch files to start and stop 

Tomcat, and use JRockit, locate the catalina.bat file associated with the Tomcat 

instance that supports GRCC. Add the following lines at the top of the file: 

set JAVA_OPTS = -Xms256M -Xmx4096M -Xgc:parallel 

-Dfile.encoding=UTF-8 

echo %JAVA_OPTS% 

set CATALINA_OPTS=-Djava.security.auth.login.config= 

"TomcatHome\webapps\grcc\WEB-INF\jaas.config" 

-Doracle.security.jps.config="TomcatHome\bin\config\jps-

config.xml" -Djava.awt.headless=true -XX:-UseGCOverheadLimit 

echo %CATALINA_OPTS% 

• If you are installing on a Windows server, use batch files to start and stop Tom-

cat, and use Sun JDK, locate the catalina.bat file associated with the Tomcat 

instance that supports GRCC. Add the following lines at the top of the file: 

set JAVA_OPTS = -Xss512k -Xms256M -Xmx4096M -XX:MaxPermSize=256m 

-XX:+UseParallelGC -Dfile.encoding=UTF-8  

echo %JAVA_OPTS% 

set CATALINA_OPTS=-Djava.security.auth.login.config= 

"TomcatHome\webapps\grcc\WEB-INF\jaas.config" 

-Doracle.security.jps.config="TomcatHome\bin\config\jps-

config.xml" -Djava.awt.headless=true -XX:-UseGCOverheadLimit 

echo %CATALINA_OPTS% 

For all the preceding setups (Linux, Windows with Sun JDK, or Windows 

with JRockit) the maximum memory setting (-Xmx) can be increased beyond 

4096M, depending on the amount of memory available on the server. 

• If you are installing on a Windows server and run Tomcat as a Windows 

service, launch an Apache Tomcat Properties window by selecting Start > 

All Programs > Apache Tomcat 6 > Configure Tomcat. Select the Java tab, 

and set the following fields. 

Add these lines to the Java Options field: 

-Djava.security.auth.login.config=TomcatHome\webapps\grcc\ 

WEB-INF\jaas.config 

-Doracle.security.jps.config="TomcatHome\bin\config\jps-

config.xml" 

-XX:-UseGCOverheadLimit 

Djava.awt.headless=true 

Dfile.encoding=UTF8 

Set the Initial Memory field to 256. 

Set the Maximum Memory Pool field to 768 or 1024. 

Set the Tread Stack Size field to 256. 

8. If you are installing on Linux, navigate to your staging directory and, from 

there, run the script file grcc_tomcat_setup.sh, with the paths to the staging 

directory, TomcatHome, and JavaHome passed as parameters. 

cmd> ./grcc_tomcat_setup.sh StagingDirectoryPath TomcatHome 

JavaHomePath 



 

 Installing or Upgrading GRCC 2-5 

If you are installing on a Windows server, navigate to your staging directory 

and, from there, run the script file grcc_tomcat_setup.bat with the paths to the 

staging directory, TomcatHome, and JavaHome passed as parameters 

cmd> ./grcc_tomcat_setup.bat StagingDirectoryPath TomcatHome 

JavaHomePath 

9. Start the Tomcat application server (or if you run Tomcat as a Windows service, 

start the service). 

10. Open a web browser and, in its address field, enter the following: 

http://host:tomcat_port/grcc 

Replace host with the FQDN of your GRCC server, and replace tomcat_port 

with 8080 (if you accepted the default value when you installed Tomcat) or 

your configured value (if you changed the default during installation).  

11. A ConfigUI panel appears, with a Properties tab selected.  

In the GRCC Configuration section, type or select the appropriate value for 

each of the following properties. (If you are upgrading, these correspond to 

values you recorded in ―Noting Your Current Settings‖ on page 2-1.) 

• User Name: Supply the user name for the GRCC database. 

• Password: Supply the password for the GRCC database.  

• Confirm Password: Re-enter the password for the GRCC database.  

• Port Number: Supply the port number at which the GRCC database server 

communicates with other applications.  

• Service Identifier: Supply the service identifier (SID) for the GRCC data-

base server.  

• Server Name: Supply the FQDN of the database server.  

• Report Repository Path: Supply the full path to the Report Repository 

directory discussed in step 2 on page 2-3.  

• Log Threshold: Select a value that sets the level of detail in log-file entries. 

From least to greatest detail, valid entries are error, warn, info, and debug.  

• Transaction ETL Path: Enter the full path to the directory you created (step 

3 on page 2-3) to hold ETL data used by Enterprise Transaction Controls 

Governor.  

• App Server Library Path: Enter the full path to the library subdirectory of 

your web application server (for use in the upload of custom connectors). If 

you use the Tomcat web application server, this is the lib subdirectory of 

the TomcatHome directory. 

12. In the Performance Configuration section on the Properties tab of the Manage 

Application Configurations panel, select or clear check boxes: 

• Externalize Report Engine: Select the check box to enable the reporting 

engine to run in its own java process, so that the generation of large reports 

does not affect the performance of other functionality. However, select the 

check box only if you have installed GRCC on hardware identified as ―cer-

tified‖ in the Governance, Risk and Compliance Applications Compatibility 

Matrix; clear the check box if you use hardware identified as ―supported.‖ 
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• Optimize Distributed Operation: Select the check box to increase the speed 

at which GRCC performs distributed operations such as data synchroniza-

tion. However, for this selection to have any effect, at least one datasource 

(page 2-9) must have an entry in its Database Agent field. (This entry, in 

turn, is a DB Link name configured externally to GRCC.) The Optimize 

Distributed Operation setting enhances performance only in GRCC exchanges 

with datasources with values entered in the Database Agent field. 

• Optimize Appliance-Based Operation: Select the check box to optimize 

performance if the GRCC application and GRCC schema reside on the 

same machine. Do not select this check box if the GRCC application and 

schema do not reside on the same machine. When you select this check box, 

an ORACLE_HOME Path field appears. In it, enter the full, absolute path to 

your Oracle Home — the directory in which you have installed the Oracle 

database that houses the GRCC schema. 

• Enable Era-Based ETL Optimization: Select this check box to cause ETCG 

data synchronization (see page 2-11) to operate only on data entered in 

business-management applications after a specified date. When you select 

this check box, an Analysis Start Date field appears. In it, enter a date from 

which you want synchronization runs to recognize data changes. When you 

click in the field, a pop-up calendar appears. Click left- or right-pointing 

arrows to select earlier or later months (and years), and then click on a date 

in a selected month. 

13. In the Language Preferences section on the Properties tab of the Manage 

Application Configurations panel, select the check boxes for up to twelve lan-

guages in which you want GRCC to be able to display information to its users. 

Once selected here, these languages are available for selection by individual 

users as they configure their user profiles or as they log on to GRCC.  

14. In the Security section on the Properties tab of the Manage Application Configu-

rations panel, set the following security values: 

• Maximum Login Attempts: Enter a number of times a user may enter an 

incorrect user name or password during login before being locked out of 

GRCC.  

• Elapsed Days Before Password Expires: Enter a number of days for which 

GRCC login passwords remain valid. When each user’s password expires, 

the user is prompted to create a new one during login. 

• Use Basic Authentication for Web Service: Select this checkbox as one step 

in integrating GRCC with an application whose database shares its user infor-

mation through LDAP technology. However, there are limitations that could 

materially affect data and functionality. Therefore, you should configure LDAP 

integration in general, and select the Use Basic Authentication for Web Service 

field in particular, only with the assistance of Oracle Consulting Services or 

another organization experienced in this type of integration for GRCC.  

15. In the Manage Application Configurations panel, click on Actions > Test to vali-

date the values you’ve entered. Upon passage of the test (if GRCC can connect 

to its database and if it can read report and ETL directory paths), an Actions > 

Save option becomes active. Select it to save the settings.  
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16. Exit the Manage Application Configurations panel.  

17. Shut down the Tomcat application server (or the Windows service in which it runs). 

As you do, close your web browser.  

18. Start the Tomcat application server and wait. 

19. Determine whether GRCC installation is complete: Open the GRCC log 

(TomcatHome/webapps/grcc/log/grcc.log) and determine whether it contains 

lines reporting the status of schema creation, patch updates, data migration 

updates, views update, stored procedures update, and overall status.  

In general, the value for each status should be ―success‖ (although the schema 

creation value may be ―not executed‖ if you are upgrading from version 8.5.1). 

No status line should report ―failed‖; if any does, contact Oracle Support. Other-

wise move on to step 20 when the log indicates GRCC installation is complete.  

20. Shut down the Tomcat application server (or the Windows service in which it 

runs). Then restart it.  

21. Open a web browser. Clear its cache, and then, in its address field, manually 

type the following URL. (This ensures that you open a fully refreshed instance 

of GRCC, rather than a cached instance that is no longer valid.) 

http://host:tomcat_port/grcc 

Replace host with the FQDN of your GRCC server, and replace tomcat_port 

with 8080 (if you accepted the default value when you installed Tomcat) or 

your configured value (if you changed the default during installation).  

Configuring Global Users 

GRCC creates a ―global user‖ for each person who uses the business-management 

applications to which AACG models and controls apply. GRCC maps the global user 

for each person to that person’s user-account information in each of the business-

management applications he uses. Thus, AACG can identify an individual even 

when his user information varies from one application to the next. 

Implement one of the following options to determine the information GRCC uses to 

create global users. Important: Select an option that identifies each person uniquely. 

• EMAIL_ONLY: Match the global user to email addresses from different 

datasources (or within one datasource). This is the default. 

• EMAIL_AND_USER_NAME: Match the global user to email address plus username 

from different datasources (or within one datasource). 

• EMAIL_AND_ALL_NAMES: Match the global user to email address, username, 

given name, and surname from different datasources (or within one datasource). 

As a regular procedure, GRCC users will ―synchronize data‖ — collect information 

required for AACG or ETCG analysis, and provide that information to GRCC. 

Ideally, you should change global-user configuration (if you wish to) before anyone 

synchronizes data with any business-management application.  
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To use the default EMAIL_ONLY option, omit the rest of this section and skip ahead to 

―Configuring Datasources and Synchronizing Data‖ (page 2-9) if either of the follow-

ing is true: 

• You are upgrading from version 8.5.1, and that version uses the default 

EMAIL_ONLY configuration. 

• You are performing a fresh installation. 

However, if you wish to change the default EMAIL_ONLY configuration, use the fol-

lowing procedure to do so. Complete steps 1–3 if you are performing a fresh instal-

lation and data synchronization has not yet been run; in this case, omit step 4.  

If you are upgrading, or if data synchronization has been performed even once, com-

plete steps 1–4. Warning: If you complete step 4 in this procedure, you may lose all 

existing data. Back up your GRCC data before initiating this procedure. 

1. Use SQL*Plus, or any other tool with the ability to execute SQL commands on 

a database, to connect to the GRCC schema.  

2. Run the following SQL statement: 

DELETE FROM LAA_PROPERTIES 

WHERE NAME like 'GLOBAL_USER_CONFIG'; 

COMMIT; 

3. Run one of the following SQL statements, depending on the global-user format 

you want to implement: 

For email and username, run the following statement: 

Insert into LAA_PROPERTIES (ID, NAME, VALUE, DESCRIPTION,  

DEFAULT_VALUE, VISIBLE, CONFIGURABLE, DATA_TYPE_ID) 

Values (GRCC_PROPERTIES_SEQ.nextval, 'GLOBAL_USER_CONFIG', 

'EMAIL_AND_USERNAME', 'Global User configuration. Possible values: 

EMAIL_ONLY, EMAIL_AND_USERNAME, EMAIL_AND_ALL_NAMES', 'EMAIL_ONLY', 0, 0, 0); 

COMMIT; 

For email, username, given name, and surname, run the following statement: 

Insert into LAA_PROPERTIES (ID, NAME, VALUE, DESCRIPTION,  

DEFAULT_VALUE, VISIBLE, CONFIGURABLE, DATA_TYPE_ID) 

Values (GRCC_PROPERTIES_SEQ.nextval, 'GLOBAL_USER_CONFIG', 

'EMAIL_AND_ALL_NAMES', 'Global User configuration. Possible values: 

EMAIL_ONLY, EMAIL_AND_USERNAME, EMAIL_AND_ALL_NAMES', 'EMAIL_ONLY', 0, 0, 0); 

COMMIT; 

For email only, run the following statement. (As already noted, email-only is 

the default configuration. Run this statement only if you have changed your 

global-user configuration to one of the other formats, and want to change back.) 

Insert into LAA_PROPERTIES (ID, NAME, VALUE, DESCRIPTION,  

DEFAULT_VALUE, VISIBLE, CONFIGURABLE, DATA_TYPE_ID) 

Values (GRCC_PROPERTIES_SEQ.nextval, 'GLOBAL_USER_CONFIG',  

'EMAIL_ONLY', 'Global User configuration. Possible values: EMAIL_ONLY, 

EMAIL_AND_USERNAME, EMAIL_AND_ALL_NAMES', 'EMAIL_ONLY', 0, 0, 0); 

COMMIT; 

4. Complete this step if you are upgrading from GRCC 8.5.1, or if you have com-

pleted a fresh installation, run data synchronization, and wish to reconfigure the 

global user after doing so. Run the following SQL statements: 
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TRUNCATE TABLE SUM_ENTITLEMENT_ENTITLEMENT; 

TRUNCATE TABLE SUM_ENTITLEMENT_POLICY; 

TRUNCATE TABLE SUM_ENTITLEMENT_PRIORITY;  

TRUNCATE TABLE SUM_ENTITLEMENT_RISK; 

TRUNCATE TABLE SUM_ENTITLEMENT_STATUS; 

TRUNCATE TABLE SUM_ENTITLEMENT_TAG; 

TRUNCATE TABLE SUM_POLICY_PRIORITY; 

TRUNCATE TABLE SUM_POLICY_STATUS; 

TRUNCATE TABLE SUM_POLICY_TAG; 

TRUNCATE TABLE SUM_POLICY_USER; 

TRUNCATE TABLE SUM_PRIORITY_TAG; 

TRUNCATE TABLE SUM_ROLE_DIMENSION; 

TRUNCATE TABLE SUM_ROLE_ENTITLEMENT; 

TRUNCATE TABLE SUM_ROLE_POLICY; 

TRUNCATE TABLE SUM_ROLE_PRIORITY; 

TRUNCATE TABLE SUM_ROLE_ROLE; 

TRUNCATE TABLE SUM_ROLE_STATUS; 

TRUNCATE TABLE SUM_ROLE_USER; 

TRUNCATE TABLE SUM_STATUS; 

TRUNCATE TABLE SUM_STATUS_PRIORITY; 

TRUNCATE TABLE SUM_STATUS_TAG; 

TRUNCATE TABLE SUM_TAG_TAG; 

TRUNCATE TABLE SUM_USER_ENTITLEMENT; 

TRUNCATE TABLE SUM_USER_TAG; 

TRUNCATE TABLE SUM_USER_STATUS; 

TRUNCATE TABLE SUM_USER_PRIORITY; 

TRUNCATE TABLE LAA_CONFLICT_PATH_JOIN_ACTN_H; 

TRUNCATE TABLE LAA_CONFLICT_PATH_ENTITL_H; 

TRUNCATE TABLE LAA_CONFLICT_PATH_ENTITLEMENT; 

TRUNCATE TABLE LAA_CONFLICT_PATH_ACCESS_H; 

TRUNCATE TABLE LAA_CONFLICT_PATH_ACCESS; 

TRUNCATE TABLE LAA_CONFLICT_PATH_JOIN_H; 

TRUNCATE TABLE LAA_CONFLICT_PATH_JOIN; 

TRUNCATE TABLE LAA_CONFLICT_FLAT; 

DELETE FROM LAA_CONFLICT_PATH_H; 

DELETE FROM LAA_CONFLICT_PATH; 

DELETE FROM LAA_CONFLICT_H; 

DELETE FROM LAA_CONFLICT; 

TRUNCATE TABLE LAA_RUN_RULE; 

TRUNCATE TABLE LAA_RUN_EXCLUSION; 

TRUNCATE TABLE LAA_RUN_SIMULATION; 

DELETE FROM LAA_RUN; 

COMMIT; 

Configuring Datasources and Synchronizing Data 

Once GRCC is installed and global-user configuration is complete, connect GRCC 

to datasources (instances of business-management applications in which it will im-

plement models and controls). Then, for each datasource, synchronize data — collect 

information required for AACG or ETCG analysis. 

GRCC creates one global user for each user in the first datasource for which you 

synchronize access data, assigning to each global user the ID configured for its user 

in that first datasource. When you synchronize data for a second datasource, GRCC 

matches users who also exist in the first datasource to their already-existing global 

user IDs. For each ―new‖ user — each of those who do not exist in the first data-

source — GRCC adopts the user ID from the second datasource as the user’s global 

ID. And so on for each datasource for which you synchronize data. 
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AACG pages display the global user ID for each business-application user. A given 

user’s ID may differ from one datasource to the next, and you may prefer to set IDs 

from a particular datasource as the global user IDs. 

It’s recommended, therefore, that you configure all datasources in which you expect 

to apply AACG models and controls before you synchronize data for any of them. 

Next, choose the datasource from which you want GRCC to adopt IDs as global user 

IDs, and synchronize that datasource first. Establish an order for the remaining data-

sources, each of which sets global IDs for users who do not exist in the datasources 

for which synchronization has already been completed. Then synchronize the remain-

ing datasources in that order. 

To configure datasources or to synchronize their data, log on to GRCC. In a web 

browser, enter the following, in which host represents the FQDN of your GRCC 

server, and tomcat_port is replaced by 8080 (if you accepted the default value when 

you installed Tomcat) or your configured value (if you changed the default during 

Tomcat installation). 

http://host:tomcat_port/grcc 

Then, click on the Navigator (a link to the left of the application, in the dark blue 

band that runs along its top). A pop-up window opens; in it, select Administration 

Management. A Tasks panel (beneath the Navigator link) then displays a list of 

Administration Management tasks; in it, select Manage Application Data.  

To configure a datasource: 

1. Ensure that the Datasources tab is selected.  

2. Click on Actions > Create New. A new row appears. Double-click in each field 

(or press Tab to move from an active field to the next field). Enter the following: 

• Datasource Name: Create a name for the datasource. 

• Description: Type a brief description of the datasource (optional). 

• Host Name: Supply the FQDN for the machine that hosts the database used 

by the business-management application. 

• Port: Enter the port number that the database uses to communicate with 

other applications. 

• User Name: Supply the user name for the database used by the business-

management application. (For an Oracle EBS instance, this is typically 

APPS.) 

• Password: Enter the password for the database. 

• Confirm Password: Re-enter the password for the database. 

• Service Identifier: Supply the SID value configured for the database in the 

tnsnames.ora file.  

• Application Type: From a list box, select the type of business-management 

application to which you are connecting — by default, EBS or PeopleSoft. 

• Version: From a list box, select the version number of the business-

management application to which you are connecting 
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• Default: Select the radio button to designate a default datasource — one 

whose data is subject automatically to models as they are saved. There can 

be only one default datasource.  

• Connector: Select a custom connector (if any have been uploaded to GRCC) 

to apply it to this datasource. Or, to use the default connector provided with 

GRCC, make no selection at all. (If so, the Connector field displays Default 

after you save the datasource.) 

A connector uses ETL technology to collect data from a business applica-

tion and provide it in a format that GRCC recognizes. The default connector 

does this for instances of Oracle EBS and PeopleSoft; it applies to any data-

source for which no custom connector is selected. 

• DB Type: From a list box, select the type of database — Oracle, MS SQL 

Server, or DB2 — used by the business-management application being con-

figured as a datasource. 

• Database Agent: Tells the Oracle Data Integrator (ODI) agent to use DB 

Link on Oracle databases. If you’ve specified a DB Link name externally 

for the datasource, enter that name here. (See step 12 on page 2-5. Also, see 

steps in the file dblink_setup.txt, which resides in the staging directory.) 

3. When you finish entering values, click on Actions > Save. 

To perform data synchronization: 

1. Ensure that the Datasources tab remains selected in the Manage Application 

Data page (see page 2-10).  

2. Select the row for the datasource with which you want to synchronize data.  

3. Do either of the following: 

• Click on Actions > Synchronize Access. Alternatively, click on the 

Synchronize button in the tool bar, then on a Run Now option, and then on 

an Access option. This causes data used by AACG to be synchronized once, 

immediately. 

If you are upgrading from version 8.5.1, you must run access synchronization 

for each datasource. (You must first have deleted the content of a directory 

that stores ETL data used by Transaction Controls Governor. This should 

have occurred when you completed step 3 on page 2-3.) 

• Click on Actions > Synchronize Transaction. Alternatively, click on the 

Synchronize button in the tool bar, then on a Run Now option, and then on 

an Transaction option. This causes data used by ETCG to be synchronized 

once, immediately. 

(You may also select another option, Actions > Schedule Synchronize, to 

establish a schedule on which data synchronization occurs regularly. For more 

on this, see the Governance, Risk and Compliance Controls User Guide.) 

Each time a datasource is synchronized, GRCC updates fields in the row for that 

datasource: Last Access Synchronization Date and Last Access Synchronization 

Status show the date of the most recent access synchronization, and its completion 

status. Last Transaction Synchronization Date and Last Transaction Synchronization 

Status do the same for the most recent transaction synchronization. 
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Determining Datasource IDs 

When you configure a datasource, GRCC assigns an ID number to it. If you intend 

to implement preventive analysis for an Oracle EBS or PeopleSoft datasource, you 

need to know its datasource ID. To determine the number, configure the datasource, 

then complete the following steps: 

1. Right-click on the header row in the grid that displays configured datasources 

(when the Datasources tab is selected in the Manage Application Data page; see 

page 2-10). 

2. A list of available columns appears. In it, select the check box for the Datasource 

ID column (click on it so that a check mark appears). 

3. Left-click anywhere outside of the list of columns to close it. 

4. The Data Administration panel now displays a Datasource ID column. In it, 

note the ID number assigned to the datasource you’ve configured. 

If, having determined the datasource IDs for your datasources, you wish to remove 

the Datasource ID column from view, repeat this procedure but clear the Datasource 

ID check box (click on it so that the check mark disappears). 
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Installing the Oracle PEA 

In support of the AACG preventive analysis feature, install a Preventive Enforce-

ment Agent (PEA) on each instance of Oracle E-Business Suite that is to be subject to 

AACG analysis. See the Governance, Risk and Compliance Applications Compati-

bility Matrix for supported versions of Oracle EBS. Even if you have installed the 

PEA for an earlier version, you must reinstall it for version 8.6.0. 

On each EBS instance for which you want to enable preventive analysis, you must 

install version 7.3.2 of Preventive Controls Governor (PCG) before installing ver-

sion 8.6.0 of the PEA. Keep the following in mind: 

• You can install GRCC 8.6.0 on its server without first having installed PCG on 

any EBS instance. If so, however, AACG would not be able to apply preventive 

analysis to Oracle EBS instances. You can implement preventive analysis sub-

sequently; to do so, you would first install PCG, then the PEA, on each EBS 

instance for which you want to enable preventive analysis.  

• Even after preventive analysis is enabled, you may choose to reinstall PCG on 

an EBS instance. If so, you must also reinstall the PEA on that instance. 

This chapter describes an automated PEA installer and a manual PEA installation 

process. If the Oracle EBS concurrent manager server and forms server reside on 

the same instance, attempt automated installation first, as it’s simpler. If not, or if 

the automated installer fails, use the manual process. In either case, first complete 

some preliminary steps that apply to both automated and manual installations. 

Preliminary Steps 

If you run your Oracle EBS instance in the Linux operating system, you must set a 

display option. To do so, execute the following command: 

export DISPLAY=localhost:1.0 

As you install the PEA, you must supply the username and password of a GRCC 

user. It’s recommended that you create a user called wsclient, and specify that user 

during PEA installation. For information on creating users, see the Governance, Risk, 

and Compliance Controls User Guide for version 8.6.0. 

When you configure an Oracle EBS instance as a GRCC datasource, GRCC gener-

ates a datasource ID number. You must supply that number as you install the PEA. 
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Thus sequence matters: Install GRCC on its server and configure each EBS instance 

as a datasource (see Chapter 2) before you install the PEA on any EBS instance.  

In the Oracle EBS instance on which you are installing the PEA, navigate to the cus-

tom application TOP (conventionally called XXLAAPPS_TOP) created on the Preven-

tive Controls Governor forms server. Execute a directory listing to determine if it 

has a subdirectory named mesg. If not, create the subdirectory: 

mkdir mesg 

Downloading and Preparing Files 

Create a staging directory on the server that supports Oracle E-Business Suite. 

When this directory is created, complete the following steps: 

1. Locate the Governance, Risk, and Compliance Controls Suite Disk in your Oracle 

media pack. On it locate grcc-peainstallation-8.6.0-SNAPSHOT-ebs-package.zip. 

Copy it to the staging directory, and extract its contents into that directory.  

The extraction should produce subdirectories of the staging directory called db, 

fndload, Forms, and lib, each of which contains files. Also, files called grcc-

peainstallation-8.6.0-SNAPSHOT.jar, install.properties, and pea.properties reside 

in the staging directory. 

2. To perform the automated installation, use a text editor to open and edit the 

install.properties file in the staging directory. (For a manual installation, this step 

is unnecessary.) Provide values for the following properties: 

• APPS_USER_NAME = APPS 

Supply the username for the database schema that supports your Oracle 

EBS instance. Typically, this value is APPS.  

• APPS_PASSWORD = apps_schema_password 

Supply the password for the Oracle EBS database schema identified in the 

previous property. 

• XXLAAPPS_USER_NAME = XXLAAPPS 

Supply the username for the database schema that supports PCG, installed on 

your Oracle EBS instance. Typically, this value is XXLAAPPS. 

• XXLAAPPS_PASSWORD = XXLAAPPS_passsword 

Supply the password for the PCG database schema identified in the previ-

ous property. 

• HOST = hostname 

Supply the host name for the Oracle EBS database server. 

• PORT = number 

Supply the port number at which the Oracle EBS database server communi-

cates with other applications. 

• SID = service_identifier 

Supply the service identifier (SID) for the Oracle EBS database server. 
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• FREQUENCY = 30 

Supply a number that sets the interval, in minutes, at which two PEA concur-

rent programs are to run. GRCC User Provisioning Poll handles the approval 

or rejection of preventive analysis requests in the Oracle EBS instance. GRCC 

User Provisioning Request Recovery transmits stored requests to GRCC 

when communications with the EBS instance have been interrupted, then 

restored. The recommended value for both programs is 30. 

3. Execute the environment file, if it is not included in the profile. Run this command: 

. $APPL_TOP/$APPLFENV 

Automated Installation 

Once you have downloaded files and prepared them, execute the following steps to 

complete an automated installation:  

1. Navigate to your staging directory. 

2. Run the installation file. Execute the following command: 

java -jar grcc-peainstallation-8.6.0-SNAPSHOT.jar -ebs 

The installation program prompts for property values required by the PEA: 

• Enter GRCC user name 

If you created a wsclient user on your GRCC instance, supply the value 

wsclient here. If not, supply the user name configured for any GRCC user. 

• Enter GRCC password 

Enter the password for the user identified in the previous property. 

• Enter GRCC server name 

Supply the fully qualified server name of the server on which GRCC is 

installed (on which Tomcat is installed and the grcc.war file is deployed; 

see ―Performing the Installation,‖ beginning on page 2-3). To verify, ping 

the GRCC server from the server where the PEA is being installed. 

• Enter GRCC port number 

Supply the Tomcat port number — 8080 (if you accepted the default value 

when you installed Tomcat) or your configured value (if you changed the 

default during Tomcat installation). 

• Enter GRCC web services URL 

This property specifies the URL of the webservice where the GRCC in-

stance is installed. This URL should be /grcc/services/GrccService/. 

• Enter GRCC web services timeout 

Enter a timeout, in seconds, for communication with the Oracle EBS server. 

The default value is 60. 

• Enter datasource ID 

Supply the datasource ID assigned by GRCC to the Oracle EBS instance in 

which you are installing the PEA. (This value is available in the GRCC Data 

Administration panel; see ―Determining Datasource IDs,‖ page 2-12). 
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The installation program updates the pea.properties file and then executes the 

installation. 

3. When the file finishes running, review its log file: In the staging directory, use a 

text editor to open the file debugInstall.log. It notes status for several installa-

tion stages (Status of Packages, Status of Concurrent Programs, Status of Load 

Java, and Status of Forms), as well as for overall installation.  

• If the status for each is Success, PEA is installed. Ignore the manual instal-

lation procedure. 

• Otherwise, the debugInstall.log file lists errors that have occurred at each 

stage. Either resolve the errors and retry the automated installation process, 

or complete the manual installation process (see the next section).  

Manual Installation  

If your Oracle EBS concurrent manager server and forms server reside on separate 

instances, or if the automated PEA installation has failed, execute a manual installa-

tion instead. Once you have downloaded files and prepared them, complete the fol-

lowing sections. 

Forms Installation 

First, install forms. The PEA uses forms in twelve languages, for which you will 

need to know language codes as you perform the installation. These codes include: 

D German KO Korean 

DK Danish NL Dutch 

E Spanish PTB Brazilian Portuguese 

F French US American English 

I Italian ZHS Simplified Chinese 

JA Japanese ZHT Traditional Chinese 

Complete the following steps: 

1. Navigate to your staging directory. 

2. Execute the following command to execute the package (PKS).  

(Here and in subsequent steps, appsSchemaName and appsSchemaPassword are the 

user name and password for the database schema used by Oracle E-Business Suite.) 

sqlplus appsSchemaName/appsSchemaPassword 

@db/grcc_provdb_pkg.pks 

3. Execute the following command to execute the package body (PKB). 

sqlplus appsSchemaName/appsSchemaPassword 

@db/grcc_provdb_pkg.pkb 

4. To set the environment variable, execute one of the following commands, once 

for each language. As you do, replace the placeholder CODE with the appropriate 

language code (see above). 
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If you use Oracle E-Business Suite Release 12: 

export FORMS_PATH=$FORMS_PATH:$AU_TOP/forms/CODE 

If you use an earlier version of Oracle EBS: 

export FORMS60_PATH=$FORMS60_PATH:$AU_TOP/forms/CODE 

5. Execute one of the following commands to compile the library: 

For Oracle E-Business Suite Release 12: 

frmcmp_batch module=Forms/GRCC_PROV.pll module_type=library 

userid=appsSchemaName/appsSchemaPassWord 

For earlier versions of Oracle EBS: 

f60gen module=Forms/GRCC_PROV.pll module_type=library 

userid=appsSchemaName/appsSchemaPassWord 

6. Execute the following command to copy the compiled library.  

cp Forms/GRCC_PROV.* $AU_TOP/resource 

7. To compile the forms, execute one of the following commands, once for each 

language. Again, as you do, replace the placeholder CODE with the appropriate 

language code (see page 3-4): 

For Oracle EBS Release 12: 

frmcmp_batch module=Forms/CODE/LAASCAUS.fmb 

userid=appsSchemaName/appsSchemaPassWord 

For earlier versions of Oracle EBS: 

f60gen module=Forms/CODE/LAASCAUS.fmb 

userid=appsSchemaName/appsSchemaPassWord 

8. To back up the compiled forms, execute the following command, once for each 

language. Again, as you do, replace the placeholder CODE with the appropriate 

language code (see page 3-4): 

cp $XXLAAPPS_TOP/forms/CODE/LAASCAUS.fmx 

$XXLAAPPS_TOP/forms/CODE/LAASCAUS.fmx.orig 

(If you followed recommendations as you installed Preventive Controls Gover-

nor, you selected XXLAAPPS as the application short name, and the environment 

variable shown in this command — $XXLAAPPS_TOP — is correct. If you chose 

another application short name as you installed Preventive Controls Governor, 

make sure the environment variable in this command and the next reflects the 

application short name you created.) 

9. To copy the compiled form, execute the following command once for each 

language. Again, as you do, replace the placeholder CODE with the appropriate 

language code (see page 3-4): 

cp Forms/LAASCAUS.fmx $XXLAAPPS_TOP/forms/CODE/LAASCAUS.fmx 

Concurrent Programs Installation  

Change to your staging directory and, from it, run the following commands to set up 

concurrent programs that support preventive analysis. In these commands: 

• appsSchemaName and appsSchemaPassword are the user name and password 

for the database schema used by Oracle E-Business Suite. 
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• XXLAAPPSUserName is the user name for the database schema that supports Pre-

ventive Controls Governor. This value is case-sensitive.  

• frequency is a number setting the interval, in minutes, between scheduled runs of 

concurrent programs (see the description of the FREQUENCY option on page 3-3).  

Execute the following command to execute the User Provisioning Poll concurrent 

program: 

sqlplus appsSchemaName/appsSchemaPassword 

@db/grccexecutable.sql XXLAAPPSUserName frequency 

Execute the following command to execute the User Provisioning Request 

Recovery concurrent program: 

sqlplus appsSchemaName/appsSchemaPassword 

@db/grccexecrecover.sql XXLAAPPSUserName frequency 

Once this initial setup is complete, execute the following command once for each of 

the eleven supported languages, so that concurrent-program messages, parameter 

names, and descriptions are available in each language. As before: 

• Replace the placeholder CODE with the appropriate language code (see page 3-4). 

• appsSchemaName and appsSchemaPassword are the user name and password 

for the database schema used by Oracle E-Business Suite. 

• stagedir is the path to the staging directory in which you copied and extracted 

PEA files. 

FNDLOAD appsSchemaName/appsSchemaPassword 0 Y UPLOAD 

$FND_TOP/patch/115/import/afcpprog.lct stagedir/fndload/CODE/ 

AACG_CONCURRENT_PROGRAMS.ldt 

Lookup Table Insertions 

From your staging directory, execute the following command to insert records in an 

LAA_lookup table. In this command, xxlaappsSchemaName and 

xxlaappsSchemaPassword are the user name and password for the database schema 

used by Preventive Controls Governor. 

sqlplus xxlaappsSchemaName/xxlaappsSchemaPassword 

@db/addproperties.sql 

Load Java 

Complete the following steps: 

1. Set the DB environment of APPS (the Oracle EBS database) and execute the 

installation program, specifying a ―manual‖ argument: 

Java –jar grcc-peainstallation-8.6.0-SNAPSHOT.jar -ebs 

-manual 

This prepares the pea.properties file to be loaded into the database (as specified 

in step 5). 

2. Execute the following commands. These commands should not error out: 

dropjava 

loadjava 
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3. Execute the following commands. Here (and in steps 4 and 5), appsUserName 

and appsPassword are the user name and password for the database used by 

Oracle E-Business Suite. 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-common-8.1.0-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-oebs-8.1.0-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-common-8.1.1-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-oebs-8.1.1-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-common-8.1.2-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-oebs-8.1.2-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-common-8.2.0-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-oebs-8.2.0-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-common-8.2.1-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-oebs-8.2.1-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-common-8.5.0-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-oebs-8.5.0-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-common-8.5.1-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing lib/ag-pea-oebs-8.5.1-SNAPSHOT.jar 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing aacg.properties 

dropjava –user appsUserName/appsPassword –verbose –resolve 

-genmissing pea.properties 

4. Execute the following commands to load the pea jar into the database.  

loadjava –user appsUserName/appsPassword –verbose –resolve 

lib/grcc-encryption-8.6.0-SNAPSHOT.jar 

loadjava –user appsUserName/appsPassword –verbose –resolve 

lib/grcc-peacommon-8.6.0-SNAPSHOT.jar 

loadjava –user appsUserName/appsPassword –verbose –resolve 

lib/grcc-peaebs-8.6.0-SNAPSHOT.jar 

5. Execute the following command to load the modified pea.properties file into the 

database: 

loadjava –user appsUserName/appsPassword –verbose –resolve 

grcc.properties 

loadjava –user appsUserName/appsPassword –verbose –resolve 

pea.properties 



 

3-8 Oracle Governance, Risk and Compliance Controls Installation and Upgrade Guide 

Postinstallation Steps 

Regardless of whether you used the automated or manual installation process, run 

the Generate Messages concurrent program once for each language. 

1. Log in to Oracle E-Business Suite as any user with the Application Developer 

responsibility. 

2. Select the Application Developer responsibility, and select the Requests: Run 

option in the Application Developer Navigator. 

3. The Submit a New Request window appears. In it, select Single Request and 

click on the OK button. 

4. The Submit Request window appears. In its Name field, query for Generate 

Messages. (Press the F11 key; type the value Generate Messages in the Name 

field; press Ctrl+F11.) 

5. A Parameter window appears. In it, enter the following: 

• Language: With each run of the concurrent program, enter one of the 

language codes shown on page 3-4. 

• Application: GRC Controls Custom 

• Mode: DB_TO_RUNTIME 

Click on the OK button. 

6. In the Submit Request window, click on the Submit button. 

7. A pop-up window informs you of an ID number for the concurrent request. 

Make a note of the number, and then click on the OK button to close the 

message. 

8. Optionally, verify that the request has been completed successfully: 

a. Click on View in the menu bar, then on Requests in the View menu. 

b. A Find Requests form opens. In it, click on the Specific Request radio 

button. Type the ID number of your concurrent request in the Request ID 

field, and click on the Find button. 

c. A Requests form opens. In the row displaying information about your 

request, ensure that the entry in the Phase field is Completed (you may need 

to click on the Refresh Data button), and the entry in the Status field is 

Normal. 

d. Close the Request form: Click on the × symbol in its upper right corner. 
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Installing the PeopleSoft PEA 

In support of the AACG preventive analysis feature, install a Preventive Enforcement 

Agent (PEA) on each instance of PeopleSoft that is to be subject to AACG analysis. 

See the Governance, Risk and Compliance Applications Compatibility Matrix for 

supported versions of PeopleSoft. Even if you have installed the PEA for an earlier 

version, you must reinstall it for version 8.6.0. 

You can install GRCC 8.6.0 on its server without installing the PEA on PeopleSoft 

instances. If so, however, AACG would not be able to apply preventive analysis to 

PeopleSoft instances. To implement preventive analysis subsequently, install the 

PEA on each PeopleSoft instance for which you want to enable preventive analysis. 

(For PeopleSoft instances, there is no requirement to install an application compar-

able to Preventive Controls Governor, which is necessary in Oracle EBS instances.) 

As you install the PEA, you must supply the username and password of a GRCC 

user. It’s recommended that you create a user called wsclient, and specify that user 

during PEA installation. For information on creating GRCC users, see the Govern-

ance, Risk and Compliance Controls User Guide for version 8.6.0. 

When you configure a PeopleSoft instance as a GRCC datasource, GRCC generates a 

datasource ID. You must supply that number as you install the PEA. Thus sequence 

matters: Install GRCC on its server and configure each PeopleSoft instance as a 

datasource (see Chapter 2) before you install the PEA on any PeopleSoft instance.  

Downloading and Preparing Files 

Create a staging directory on the server that supports a PeopleSoft Financials or HR 

instance. When this directory is created, complete the following steps: 

1. Locate the Governance, Risk, and Compliance Controls disk in your Oracle media 

pack. On it locate grcc-peainstallation-8.6.0-SNAPSHOT-ps-package.zip. Copy it 

to the staging directory, and extract its contents into that directory. 

The extraction should produce subdirectories of the staging directory called lib, 

GRCC_AGENT_86_PS_FIN90, and GRCC_AGENT_86_PS_HR90, each of which 

contains files. Also, files called grcc-peainstallation-8.6.0-SNAPSHOT.jar, 

pea.properties, and log4j.properties reside in the staging directory. 
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2. Execute the installation program to update the pea.properties file: 

java –jar grcc-peainstallation-8.6.0-SNAPSHOT.jar -psft 

The installation program prompts for property values required by the PEA: 

• Enter GRCC user name 

If you created a wsclient user on your GRCC instance, supply the value 

wsclient here. If not, supply the user name configured for any GRCC user. 

• Enter GRCC password 

Enter the password for the user identified in the previous property. 

• Enter GRCC server name 

Supply the fully qualified server name of the server on which GRCC is 

installed (on which Tomcat is installed and the grcc.war file is deployed; 

see ―Performing the Installation,‖ beginning on page 2-3). To verify, ping 

the GRCC server from the server where the PEA is being installed. 

• Enter GRCC port number 

Supply the Tomcat port number — 8080 (if you accepted the default value 

when you installed Tomcat) or your configured value (if you changed the 

default during Tomcat installation). 

• Enter GRCC web services URL 

This property specifies the URL of the webservice where the GRCC in-

stance is installed. This URL should be /grcc/services/GrccService/. 

• Enter GRCC web services timeout 

Enter a timeout, in seconds, for communication with the Oracle EBS server. 

The default value is 60. 

• Enter datasource ID 

Supply the datasource ID assigned by GRCC to the Oracle EBS instance in 

which you are installing the PEA. (This value is available in the GRCC Data 

Administration panel; see ―Determining Datasource IDs,‖ page 2-12). 

• Enter PeopleSoft SID 

Supply the service identifier (SID) for the PeopleSoft database server. 

• Enter PeopleSoft port: 

Supply the number for the port at which the PeopleSoft database server 

communicates with other applications. 

• Enter PeopleSoft FQDN 

Supply the fully qualified domain name of the PeopleSoft database server. 

• Enter PeopleSoft user name 

Supply the user name for the PeopleSoft database schema. 

• Enter PeopleSoft user password 

Supply the password configured for the username identified in the previous 

property. 
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• Enable PeopleSoft PEA? (y/n) 

Enter the value y to enable the PEA, or the value n to disable the PEA. 

• Enter log4j properties location 

Specify the path to a directory in which the log4j.properties file will reside 

— PS_HOME\appserv\classes\log4j.properties, in which PS_HOME represents 

the full path to the highest level directory in which PeopleSoft components 

are installed.  

(In step 3, you’ll edit a copy of this file that’s located in your staging direc-

tory. During installation, the file will be copied from the staging directory to 

a place where it can be used, and this property tells where it should be copied.) 

• Enter PEA log location 

Set the path an name of a log file that records information about communi-

cations between PeopleSoft and GRCC. The path is PS_HOME\appserv\APP 

\LOGS\grcc-peapsclient.log, in which PS_HOME represents the full path to 

the highest level directory in which PeopleSoft components are installed, 

and APP is replaced by FIN or HR, depending on whether the PEA is being 

install on an instance of PeopleSoft Financials or Human Resources. 

• Enter interval for PEA poller 

Set a time interval, in minutes, at which an ―GRCC poller‖ may be scheduled 

to run. The poller updates role assignments for PeopleSoft when the assign-

ments have been resolve in the GRCC Manage Access Approvals page. In 

the Roles panel of the PeopleSoft User Profiles page, a user may select a link 

labeled ―Schedule GRCC Poller‖; if so, the poller runs at intervals defined 

by this parameter. 

The installation program generates a temporary folder in the staging directory; it 

contains grcc-peaps-8.6.0-SNAPSHOT.jar for installation of PEA on PeopleSoft. 

3. In the staging directory, use a text editor to open and edit the log4j.properties 

file. Set the following property: 

log4j.appender.file.File = PS_HOME\appserv\APP\LOGS\grcc-

peapsagent.log 

In this value, replace PS_HOME with the full path to the highest level directory in 

which PeopleSoft components are installed, and APP with FIN or HR, depending 

on whether the PEA is being install on an instance of PeopleSoft Financials or 

Human Resources. 

Do not modify the values of other properties in the log4j.properties file. 

Installing the PEA 

Once you have downloaded files and prepared them, execute the following steps: 

1. Stop the PeopleSoft application server.  

To do so, use the psadmin utility: To start it, execute the command 

PS_HOME\appserv\psadmin (on a Linux server) or PS_HOME\appserv\psadmin.exe 

(on a Windows server). In either case, replace PS_HOME with the full path to the 
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highest-level directory in which PeopleSoft components are installed. If neces-

sary, see PeopleSoft documentation for information on using the psadmin utility. 

2. From the PS_HOME\appserv\classes directory, remove any jar files that start with 

―grcc,‖ ―ag,‖ or ―aacg.‖ 

3. Copy the following files from the lib subdirectory of your staging directory to 

the PS_HOME\appserv\classes directory: 

grcc-peacommon-8.6.0-SNAPSHOT.jar 

grcc-encryption-8.6.0-SNAPSHOT.jar 

commons-logging-1.1.jar 

log4j-1.2.14.jar 

ojdbc14-10.2.0.3.jar 

4. Copy the following file from the your staging directory to the PS_HOME\appserv\ 

classes directory: 

grcc-peaps-8.6.0-SNAPSHOT.jar 

(The temporary folder was generated by the running of the installation 

program.) 

5. Copy the log4j.properties file from your staging directory to the directory you 

specified for it in the ―Enter log4j properties location‖ property when you ran 

the grcc-peainstallation-8.6.0-SNAPSHOT.jar file. 

6. Use the psadmin utility to restart the PeopleSoft application server. (See step 1 

for information on running the psadmin utility.) 

Importing a Project 

To complete the PEA installation, import a PeopleTools project: 

1. Open the PeopleTools Application Designer. Log in as a user who has the 

PeopleSoft administrator role.  

2. Navigate to Tools > Copy Project > From File… 

3. A Copy From File dialog opens. In a field labeled ―Look in:‖ navigate to your 

staging directory. This causes subdirectories of the staging directory to appear in 

the large, unlabeled field below the ―Look in:‖ field, and the names GRCC_AGENT_ 

86_PS_FIN90 and GRCC_AGENT_86_PS_HR90 to appear in the a field labeled 

―Select Project from the List Below.‖ A Select button also becomes active. 

4. For PeopleSoft 9.0 or 9.1 Financials, select GRCC_AGENT_86_PS_FIN90 in the 

―Select Project‖ field, and click on the Select button. For PeopleSoft 9.0 or 9.1 HR, 

select GRCC_ AGENT_86_PS_HR90 in the ―Select Project‖ field, and click on the 

Select button. 

5. When the Copy from File dialog appears, click on the Copy button. After the 

Progress dialog disappears, confirm that application objects appear in the Applica-

tion Designer project window and click on the Save All icon or File > Save All. 

It’s important to follow instructions in the PeopleSoft Application Import/Update 

Installation Guide when you apply an application import/update project to your data-

base. Failure to do so could corrupt your database and cause you to lose customiza-

tions that you have made to your database. 
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Resetting Passwords 

Passwords for Governance, Risk and Compliance Controls users expire, and must 

be reset, periodically. (The period is set in the Properties tab of the GRCC Manage 

Application Configurations panel; see step 14 on page 2-6). This gives rise to two 

distinct issues: 

• An admin user, which exists by default in every instance of GRCC, gives rights 

to all functionality offered by GRCC. A utility exists to reset this user’s password 

if the user account should become locked. 

• When you install a Preventive Enforcement Agent on an instance of Oracle EBS 

or PeopleSoft, you must specify a GRCC user, known conventionally as wsclient. 

When this user’s password expires and is reset on GRCC, it is out of sync with 

the password specified on each Oracle EBS or PeopleSoft instance. A utility 

exists to change the password on those instances so that it matches the password 

when it has been reset on GRCC. 

Resetting the Admin Password 

Governance, Risk and Compliance Controls comes with one user account created by 

default. Both its user name and password are admin, and it is assigned an admin role, 

which gives rights to all functionality offered by GRCC. 

Because the admin user is powerful, one is advised to create another administrative 

user and use the seeded admin user as a backup. Moreover, in the event that the admin 

user’s password cannot be reset by normal means (if, for example, the account is 

locked because a user made too many consecutive incorrect attempts to log on), the 

password can be reset through the use of a password reset utility: 

• You can run the utility only from the command line on the server on which 

GRCC is installed. To do so, you must have privileges to run the utility on the 

server. 

• You must know GRCC schema information, including the GRCC password. 

To run the utility, navigate to TomcatHome/webapps/grcc/lib. From there, execute 

the password-reset jar file, as follows: 

java –jar grcc-utility-8.6.0-SNAPSHOT.jar 
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You will then be prompted to enter GRCC schema information. Once you’ve done 

so, you will be prompted to enter a new password. It must meet password require-

ments: A password is case-sensitive and must consist of at least eight characters, 

taken from each of four character sets: uppercase letters, lowercase letters, numbers, 

and special characters, which comprise !@#$%&*. Moreover, the password must not 

match any of the previous three passwords, and it is invalid if it matches or contains 

the user name. 

The following is sample output of the password-reset utility: 

Enter schema host name: someserver.hq.host.com 

Enter schema port: 1521 

Enter schema sid: orcl 

Enter schema username: grcc_86a 

Enter schema password: grcc_86a 

Verifying schema. Please wait ... 

Enter new 'admin' password: 

Resetting the Password of the PEA User 

If your organization installed Preventive Enforcement Agents (PEAs) in Oracle 

EBS and PeopleSoft instances, it specified a GRCC user during PEA installation. (It 

was recommended that a user called wsclient be created for this purpose, but any 

GRCC user could in fact have been designated.) 

Periodically, an administrator must log on to GRCC and reset the password for this 

user. The administrator would use the GRCC User Administration page to reset this 

password. (See the Governance, Risk and Compliance Controls User Guide.) 

Immediately after doing so, the administrator would need to change the password in 

each Oracle EBS or PeopleSoft instance on which a PEA is installed, so that it matches 

the newly changed password on GRCC. 

To reset the password on PEA instances, complete the following steps: 

1. As the PEA was installed, a staging directory was created on the Oracle EBS or 

PeopleSoft instance. Navigate to that staging directory.  

2. Execute the following command: 

java -jar grcc-peainstallation-8.6.0-SNAPSHOT.jar -changepassword 

3. The program prompts for property values required by the PEA. Enter the follow-

ing. (Except for the password, these values are the same as those specified when 

the PEA was installed.) 

• Enter GRCC user name 

Enter the user name of the GRCC user that was specified during PEA instal-

lation. As noted, the recommended value is wsclient. 

• Enter GRCC password 

Enter the new password you’ve just created in GRCC for the user specified 

during PEA installation.  
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• Enter GRCC server name 

Supply the fully qualified server name of the server on which GRCC is 

installed (on which Tomcat is installed and the grcc.war file is deployed; 

see ―Performing the Installation,‖ beginning on page 2-3). To verify, ping 

the GRCC server from the server where the PEA was installed. 

• Enter GRCC port number 

Supply the Tomcat port number — 8080 (if you accepted the default value 

when you installed Tomcat) or your configured value (if you changed the 

default during Tomcat installation). 

• Enter GRCC web services URL 

This property specifies the URL of the webservice where the GRCC in-

stance is installed. This URL should be /grcc/services/GrccService/. 

• Enter GRCC web services timeout 

Enter a timeout, in seconds, for communication with the Oracle EBS server. 

The default value is 60. 

• Enter datasource ID 

Supply the datasource ID assigned by GRCC to the Oracle EBS instance in 

which you are installing the PEA. (This value is available in the GRCC Data 

Administration panel; see ―Determining Datasource IDs,‖ page 2-12). 

The program updates the pea.properties file and then executes password change. 
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